
Recall  
for  

Windows 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

LP101006 Rev 2.10 
November 2000 

 
 



As part of our continuous product improvement policy, we are always pleased to 
receive your comments and suggestions about how we should develop our product 
range. We believe that the manual is an important part of the product and would 
welcome your feedback particularly relating to any omissions or inaccuracies you 
may discover. 
 
You can send your comments to:- 
 
MKS Instruments, Spectra Products 
Cowley Way 
Weston Road 
Crewe 
Cheshire 
CW1 6AG 
U.K. 
 
+44 1270 250150 Tel. International 
+44 1270 251939 Fax. International 
 
01270 250150 Tel. U.K. 
01270 251939 Fax. U.K. 
 
In North America you can send your comments to:- 
 
MKS Instruments, Spectra Products 
700A East Dunne Ave. 
Morgan Hill 
CA 95037 
 
(408) 778 6060 Office 
(408) 776 8575 Fax 
 
 
 
 
 
 
 
 
 
 
 
Windows is a trademark of the Microsoft Corporation. All other brand or product names are 
trademarks or registered trademarks of their respective companies. 
 



 

Recall Manual 
LP101006 Rev 2.10   Nov. 2000 Page 1 

Contents 
 
Section 1. Getting started.......................................................................................... 3 

1.1.   Getting help.................................................................................................... 3 
1.2.   Manual conventions ....................................................................................... 3 
1.3.   Introducing Recall.......................................................................................... 4 
1.4.   Making a backup copy ................................................................................... 5 
1.5.   Installing Recall ............................................................................................. 5 
1.6.   The guided tour .............................................................................................. 6 

1.6.1.   Starting Recall......................................................................................... 6 
1.6.2.   Opening a file.......................................................................................... 7 
1.6.3.   The Main window ................................................................................... 7 
1.6.4.   Recall scan info..................................................................................... 11 
1.6.5.   Viewing scans ....................................................................................... 12 
1.6.6.   Opening other file windows .................................................................. 12 
1.6.7.   Hiding buttons....................................................................................... 13 
1.6.8.   Viewing trend scans .............................................................................. 14 
1.6.9.   Log axis................................................................................................. 14 
1.6.10.   Creating your own library ................................................................... 15 

1.7.   Using help .................................................................................................... 16 
1.7.1.   About Recall ......................................................................................... 16 

Section 2. Technical Reference ................................................................................. 1 
2.1.   File commands ............................................................................................... 1 

2.1.1.   Opening a file.......................................................................................... 1 
2.1.2.   Multi head/valve files.............................................................................. 2 
2.1.3.   Closing a file ........................................................................................... 2 
2.1.4.   Browsing................................................................................................. 3 
2.1.5.   File log .................................................................................................... 3 
2.1.6.   Printing.................................................................................................... 4 
2.1.7.   Show as . . . ............................................................................................. 6 
2.1.8.   Scan clipboard......................................................................................... 7 
2.1.9.   Defaults ................................................................................................... 7 
2.1.10.   Exiting Recall...................................................................................... 10 

2.2.   Libraries ....................................................................................................... 10 
2.2.1.   The Spectra library................................................................................ 11 
2.2.2.   Library manager.................................................................................... 11 
2.2.3.   Creating a new library........................................................................... 12 
2.2.4.  Opening and creating folders. ................................................................ 12 
2.2.4.   Opening and creating folders ................................................................ 12 
2.2.5.   Populating a library folder .................................................................... 13 
2.2.6.   Finding scans ........................................................................................ 13 
2.2.7.   Library menu......................................................................................... 14 

2.3.   Goto commands ........................................................................................... 19 
2.3.1.   Next....................................................................................................... 20 



 

Recall Manual 
LP101006 Rev 2.10   Nov. 2000 Page 2 

2.3.2.   Previous ................................................................................................ 20 
2.3.3.   Jump forward ........................................................................................ 20 
2.3.4.   Jump Backward..................................................................................... 21 
2.3.5.   Last ....................................................................................................... 21 
2.3.6.   First ....................................................................................................... 21 
2.3.7.   Scan Number......................................................................................... 21 
2.3.8.   Span settings ......................................................................................... 22 

2.4.   View commands........................................................................................... 22 
2.4.1.   Y-axis.................................................................................................... 23 
2.4.2.   X-axis.................................................................................................... 23 
2.4.3.   Cursor info ............................................................................................ 23 
2.4.4.   Peak surround ....................................................................................... 24 
2.4.5.   Alarms................................................................................................... 24 
2.4.6.   Grid....................................................................................................... 24 
2.4.7.   Total pressure........................................................................................ 25 
2.4.8.   Button bar ............................................................................................. 25 
2.4.9.   Settings bar ........................................................................................... 25 
2.4.10.   Copy to clipboard................................................................................ 25 
2.4.11.   Vertical legend.................................................................................... 25 
2.4.12.   Continuous trace ................................................................................. 26 
2.4.13.   Redraw................................................................................................ 26 
2.4.14.   Analogue............................................................................................. 26 
2.4.15.   Edit text............................................................................................... 26 
2.4.16.   Edit peaks............................................................................................ 27 
2.4.17.   Paste from clipboard ........................................................................... 28 
2.4.18.   Paste merge from clipboard ................................................................ 28 

2.5.   Channel menu .............................................................................................. 29 
2.5.1.   The channel window ............................................................................. 29 

2.6.   Window commands ..................................................................................... 30 
2.6.1.   Cascading.............................................................................................. 30 
2.6.2.   Arrange icon ......................................................................................... 30 
2.6.3.   Tiling .................................................................................................... 30 
2.6.4.   Info window.......................................................................................... 31 
2.6.5.   Clipboard window................................................................................. 31 

2.7.   Help ............................................................................................................. 31 
2.7.1.   Contents ................................................................................................ 31 
2.7.2.   Searching .............................................................................................. 31 
2.7.3.   Getting started....................................................................................... 32 
2.7.4.   About .................................................................................................... 32 
2.7.5.   Printing help pages................................................................................ 32 
2.7.6.   Help notes ............................................................................................. 33 

2.8.   Switches....................................................................................................... 33 
2.8.1.   Software switches ................................................................................. 34 

 
 



 

Recall Manual 
LP101006 Rev 2.10   Nov. 2000 Page 3 

Section 1. 
Getting started 
 
In this section of the manual we will explain the basic function of Recall for 
Windows, install the software on your PC and provide an introductory tour of Recall 
to get you familiar with the basic features. This will also check that Recall is working 
correctly. If you are a new user of Recall for Windows we strongly recommend you 
to work through this section. If you have already used earlier versions of Recall we 
suggest you work through the tour to check everything is working. 
 
 
1.1.  Getting help 
We are always please to provide assistance where we can. If you experience any 
difficulties or need help please feel free to call your local Spectra facility and ask for 
the service department. Please have the following information ready so that our 
technical staff may help you quickly and effectively: 
 
The information displayed in the Help About form. To access this select Help | 
About from the menu bar as described in section 1.7.1.  About Recall. 
 
 
1.2.  Manual conventions 
Text Conventions 
 
As far as possible Recall for Windows uses a format and conventions common to 
other Windows software packages. The following text formatting conventions are 
used throughout this manual: 
 
 
Italic type   Windows terms. You can refer to your Windows manual 

for more information 
 
Bold type names on buttons 

names of menus 
Words or characters you should type. Example if the 
manual instructs you to type cd spectra you type the 
lowercase letters cd followed by a space and the 
lowercase letters spectra. 

 
Keyboard Conventions 
 
Function key names are written in uppercase letters. Example, the Control key is 
written CTRL, the Escape key ESC. 
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Where keys need to be pressed simultaneously the + sign is used. Example ALT+F1 
means hold down the ALT key while pressing the F1 key. 
 
Where keys are pressed in sequence commas are used. Example: ALT, C, D would 
mean press the ALT key then press C then press D. 
 
Where one of the four arrow keys is referred to the appropriate symbol is used 
enclosed in parentheses. Example, up arrow is written (↑). 
 
Mouse Conventions 
 
Recall for Windows only uses one mouse button. If you have a mouse with more 
than one button the left mouse button is the one you will use unless you have 
configured your mouse differently.  
 
Point Position the mouse pointer so that it rests on the object you have 

been instructed to point to. 
 
Click Press then immediately release the mouse button without moving 

the mouse. 
 
Double Click Press then immediately release, press again then immediately 

release the mouse button without moving the mouse. 
 
Drag Point to the object to be moved, press and hold down the mouse 

button whilst moving the mouse to reposition the object. Then 
release the mouse button. 

 
 
1.3.  Introducing Recall 
Recall for Windows is a software package which allows you to view data files which 
have been stored using the disk store facility in RGA for Windows. There are two 
editions of Recall for Windows; the Standard Edition is supplied with RGA for 
Windows, the Analytical Edition is available as an option. The Standard Edition is 
described in this manual and the additional features of the Analytical Edition are 
described in a supplemental manual. We will explain how to check which type you 
have after describing the installation process.  
 
Recall for Windows and RGA for Windows may be run on the same PC, 
simultaneously, which permits data analysis while acquiring new data. Recall for 
Windows does not require an RGA control unit to be connected to the PC nor does 
RGA for Windows have to be installed to allow Recall to be used. Many users install 
Recall with RGA for Windows on the PC used for data acquisition, in the laboratory 
say, then install Recall on the PC in their office as well.  
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Supplied with Recall are three data files which you can use to learn about Recall 
without having to use RGA for Windows to acquire data, we will refer to these 
throughout the manual. 
 
 
1.4.  Making a backup copy 
If you have not already done so you should generate  backup disks from the program 
disks supplied. To do this use the MS-DOS DISKCOPY utility (or any other method you 
are familiar with) to make a copy of the original disks. Keep the original disks in a safe 
place and only use the copy. 
 
 
1.5.  Installing Recall 
The Standard Edition of Recall for Windows will usually be installed along with 
RGA for Windows and this is described in the RGA for Windows manual. If you are 
installing Recall on a PC without RGA for Windows or are installing the Analytical 
Edition of Recall please follow the instruction below. 
 
If you are installing the Analytical Edition and already have the Standard  
Edition installed it will be overwritten by the Analytical Edition. Don’t worry, all the 
features in the Standard Edition are also in the Analytical Edition. 
 
The Standard Edition of Recall is supplied on the same disks as RGA for Windows. 
The Analytical Edition of Recall is supplied on its own disk. We assume you will use 
drive A but of course you may use drive B if you prefer, just substitute drive B for 
drive A in the instructions below. 
 
To install Recall for Windows: 
 
1. Run up Windows 
 
2. Insert the RGA for Windows disk 1 into drive A of your PC if you are 

installing the Standard Edition or if you are installing the Analytical Edition 
insert the single disk which has been supplied. 

 
3. Chose the Run . . . option from the Windows Program Manager File select 

menu. 
 
4. Type a:install . 
 
 The Spectra Install window will be displayed.  
 If it is the Standard Edition there will be five products in the install list: 
 
 RGA for Windows 
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 Download 
 Recall 
 DDE Examples 
 Macro Examples 
 

To install Recall only, click on the check box for each of the other four 
products to leave Recall as the only product which is checked (has a X in the 
square box).  

 
 If it is the Analytical Edition you will only have the one product option to 

install. 
 
 You may also change the directory where Recall for Windows will be installed. 

For the purposes of this manual we will assume you use the default directory 
C:\SPECTRA\. 

 
5. Click on the Install button to begin the installation process. Insert disk two if, 

and when, prompted to do so. 
 
6. Recall for Windows will be installed on your hard drive and a program group 

called Spectra will be created (if it does not already exist) and the program 
items Recall and Recall Help will be added. If you are replacing the Standard 
Edition with the Analytical Edition the Recall item will be replaced with the 
Analytical Recall program item. 

 
This completes the installation process. 
 
 
 
 
1.6.  The guided tour 
This part of the manual will get you up and running using Recall for Windows, it will 
also check that everything is working after the installation process. We do assume 
that you are familiar with the Windows environment. We have made every effort to 
use standard terminology so that you can quickly refer to the Microsoft Windows 
manual for detailed information about specific windows topics. 
 
 
1.6.1.  Starting Recall  

Starting Recall for Windows is very easy and is just like starting other Windows 
programs. 
 
From the Windows Program Manager double click on the Spectra icon to open the 
Spectra program group.  
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In the Spectra program group double click on the Recall icon. 
 
The Recall window will be opened. Click on the maximize button (refer to your 
Windows manual if you are unsure) so that the Recall window uses the full screen. 
 
 
1.6.2.  Opening a file  

As mentioned earlier three data files have been supplied with Recall and were copied 
into the Spectra directory during the installation process. The three files are named: 
 
recall.wbg 
recall.wpj 
recall.wmt 
 
and are respectively a Bar Chart file, a Peak Jump file and a Multi Trend file. 
 
As with other Windows applications, operations can often be started in a number of 
ways and this is true for opening a file in Recall. For now we will try one method the 
others are explained in the technical reference section of the manual. 
 
To open the Bar Chart file recall.wbg: 
 
Select File | Open . . .  from the menu bar ( to do this click on File then click on 
Open . . .  ) the Open dialog box will then be displayed. 
 
In the File Name: box there should be three files listed: 
recall.wbg 
recall.wpj 
recall.wmt 
 
click on recall.wbg then click on the OK button. 
The file will be opened and will be displayed in the scan window. Another window 
called the Recall (Scan Info) window has been opened but is hidden behind the main 
Recall window. Click on Window on the menu bar then click on Info Window in the 
menu list. The Recall (Scan Info) has been brought to the front and is now visible. 
The screen should look similar to Figure 1 which we have annotated to describe the 
various parts of the Recall screen. 
 
 
1.6.3.  The Main window 

Figure 1 shows the Main Recall Window when one file has been opened. Below is a 
description of the main parts of the Recall window. 
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Figure 1   The Recall screen 
 
 
1.6.3.1.  Menu bar 
 
All the functions in Recall for Windows may be accessed via the menu bar, just as 
they can in other Windows software packages. There are nine menus; File, View, 
Library, Goto, Channel, Window, and Help. Not all of these are displayed at the 
same time, the menu bar will change depending on the type of window which is 
open. 
 
 
1.6.3.2.  Main window button bar 
 
The button bar contains a series of buttons for the most commonly used functions 
refer to Figure 2 for the name of each button, below is a brief description of the 
function of each button. 
 
 

Menu bar 
Button bar 

Application title bar

Settings 
b

Scan window 

Recall (Scan information) 
i d
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Figure 2  Button bar 
 
Open button Click on this button to display the open file dialog box. 
 
Open log button Allows the user to open a file log by first opening the Select a 

Directory dialog box. 
 
Library Opens the Library Manager dialog box from where a library 

may be opened or created. 
 
Print button Prints the current scan by first opening the Print dialog box. 
 
Close button Click on this button to close the active scan window. 
 
First Goto the first scan in the file or library. 
 
Jump backward Jump back through the file or library by 10% of the total 

number of scans. 
 
Previous Goto the previous scan in the file or library. 
 
Next Goto the next scan in the file or library. 
 
Jump forward Jump forward through the file or library by 10% of the total 

number of scans. 
 
Last Goto the last scan in the file or library. 
 
Goto Opens a dialog box so that you may goto any scan in the file 

or library. 
 

 

 
 
 
 
 
 
 
 
 
 
 

Goto button 
Last button 

Jump forward button 

First button 
Jump backwards button 

Previous button
Next button 

Close button
Print button 

Library button 
Open log button 

Open button 
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1.6.3.3.  Scan window 
 
The  Scan Window is a child window which contains the actual scan data. In the case 
of Figure 1 it contains a Bar Chart scan. Since Recall is a multiple document 
application we can open many Scan Windows all within the Recall Window. 
 
 
1.6.3.4. Recall Settings Bar 
 
The Recall settings bar is a set of buttons displayed in the Scan Window above the 
scan data. These buttons allow the user to alter the view of the scan and enable some 
additional features. The buttons in the settings bar will change depending on the type 
of file being displayed. Below is a brief description of the function of each button. 
 

 
 

Cursor button Click on this button to enable/disable the 
cursor. 

   
 

Grid button Click on this button to enable/disable the 
grid. 
 

    
 

Total pressure button Enables/disables the display of the total 
pressure 

 
 

Mass span button Changes the mass span displayed on the x-
axis. 

 
 

Background subtract Subtracts the background scan from the 
current display. This is only available in 
the analytical edition of Recall for 
Windows. 

 
 

Log low range increase Increases the low gain range by one decade 
in logarithmic display. i.e.  1x10-7 to 1x10-8 

 
Log low range decrease Decreases the low gain range by one 

decade in logarithmic display. i.e.  1x10-7 
to 1x10-6 

 
Log high range increase 
 

Increases the high gain range by one 
decade in logarithmic display.  i.e.  1x10-9 
to 1x10-10 

 
Log high range decrease Decreases the high gain range by one 

decade in logarithmic display.  i.e.  1x10-9 
to 1x10-8 

 
 

Alarms button Enables/disables the display of alarm 
settings in peak jump files. 
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Peak surround Enables/disables the peak surround in peak 
jump files. 

 
 

Log button Click on this button to switch between a 
logarithmic and a linear y-axis. 

 
 

Continuous trace Enables the continuous trace (join the dots) 
with trend files. 

 
 

Vertical labels Toggles between vertical and horizontal 
display of the time labels on the x-axis in 
trend displays. 

 
 

Analogue Shows an analogue scan as analogue. 

 
 

Bar chart Shows an analogue scan as a bar chart. 

 
 

Twin display Shows an analogue scan as a twin 
analogue/bar chart display. 

 
Update time Click on this button to display the time and 

date of the last update when viewing a 
literature folder library scan. 

 

 
 

Information window Displays the library information window. 

 
 
1.6.3.5.  Scan information window 
 
The Scan Information Window contains useful information relating to the data file 
currently being displayed. Whilst many Windows may be opened there will only be 
one Scan Information Window, the information it contains will relate to the active 
File Window. The information held in the comment box may be edited in Recall but 
none of the other fields may be changed. 
 
 
1.6.4.  Recall scan info 

When you opened the data file recall.wbg, two document or child windows were 
opened. One is the Scan Window the second is the Recall Scan Information window, 
refer to Figure 1. The Scan Info window contains data which was stored at the same 
time as the scan data in RGA for Windows, such as the accuracy, mass range and 
which filament was on. Also any comment that was stored will be displayed. This is 
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the only information in the Scan Info window which may be edited in Recall. 
 
It will often be found useful to edit the comment prior to printing a scan. To edit the 
comment simply position the cursor in the comment field then use the arrow keys to 
move around the comment, new text may be typed in and text may be deleted using 
the BACKSPACE and DELETE keys. Try editing the comment. 
 
When you close the file you will be prompted to save the changes in the comment 
field. 
 
Close the Scan Information Window by clicking on the Scan button. It can be re-
opened at any time by selecting Window | Info Window from the menu bar or 
pressing CTRL+I. 
 
 
1.6.5.  Viewing scans 

The file recall.wbg which you have opened contains 20 scans and at the moment you 
are viewing the first of these 20 scans. The scan number, time and date when the scan 
was stored are displayed to the right of the settings bar. To view the second of the 20 
scans click on the Next button on the icon bar, refer to figure 2 for button 
descriptions. 
 
Notice that now the scan number reads 2 of 20 and the time has changed. Now click 
on the Jump forward button to move to scan 7 of 20.  
 
 
1.6.6.  Opening other file windows 

Recall for Windows is a multiple document application which means that any 
number of file windows may be opened simultaneously. Also, the same file may be 
opened more than once so that different parts of the file may be viewed 
simultaneously. 
 
Open the recall.wbg file by; selecting File | Open . . . from the menu bar, click on 
recall.wbg in the File Name: box then click on the OK button. A second child 
window will be opened showing scan 1 of 20 of the recall.wbg file. Now open a third 
child window by selecting File | Open . . . from the menu bar, click on the List Files 
of Type: dropdown list box to display the list then click on Multi Trend (*.wmt). The 
File Name: box will now show one item, recall.wmt, click on this then click on the 
Ok button. 
 
The last two windows which were opened are shown cascaded, they are on top of 
each other with the title bars visible. The three windows can be shown so that they 
are all visible. To do this click on Window in the menu bar then click on Tile 
Horizontal from the menu list. The three child windows are shown on the screen one 
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above the other. Notice that the Multi Trend child window is the active window 
because it was the top most window when the three windows were cascaded. This is 
denoted by the colour of the title bar which will be different to the other two child 
windows. 
 
Note that the colour of the active title bar and the inactive title bars will depend on 
your Windows configuration setup in Main | Control Panel | Color. It is possible to 
have both active and inactive title bars the same colour. We recommend you to avoid 
this. 
 
 
1.6.7.  Hiding buttons 

Unfortunately, with having three scan windows displayed simultaneously we run 
short of screen space to display data. However, we can gain some extra screen space 
by not displaying the button bar. Click on View in the menu bar to display the View 
menu, click on Button Bar in the menu (note the   next to Button Bar indicating that 
it’s currently being displayed). The button bar at the top of the screen will have gone 
and the three scan windows will have expanded to use the additional space. 
 
We can also choose not to display the settings bar in each of the scan windows. Click 
on View in the menu bar then click on the Settings Bar menu item. The settings bar 
in the multi trend window will have been disabled and the data will have expanded to 
use the extra space. The settings bar in the other two windows can be disabled, firstly 
make the window the active window by clicking anywhere in it, notice the title bar 
change colour. Then, select View | Settings Bar from the menu bar. You can then 
repeat this for the third child window. 
 
The last thing we can do to gain screen space for the display of partial pressure data 
is to disable the total pressure display. Make the centre child window the active 
window then click on View on the menu bar. In the View menu click on Total 
Pressure. The total pressure reading will have disappeared and the scan data will 
have expanded to use the additional screen space. Now, make the bottom child 
window the active window then press CTRL+T (hold down the control key and 
press the T key on your keyboard) notice that the total pressure display has gone. 
You may have noticed Ctrl+T shown after Total Pressure in the View menu. Like 
most Windows applications operations in Recall for Windows may be performed a 
number of ways. If the settings bar had been displayed we could have disabled the 
total pressure display by clicking on the Total Pressure button. 
 
Close the two child windows showing the bar chart scans by selecting File | Close 
from the menu bar to close the bottom window. Make the remaining bar chart 
window the active window then click on the Close button on the button bar. Again, 
there is more than one way to carry out an operation. You should now be left with 
just one child window showing the multi  trend scan. Click on the maximize button in 
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the top right corner of the child window so that the trend scan fills the Recall 
window. 
 
 
1.6.8.  Viewing trend scans 

Multi trend, leak check and fast scan files show more than one scan of data on the 
screen. Therefore, viewing data is slightly different than from viewing bar chart, 
peak jump and analogue files where only one scan is shown at a time. The multi 
trend file currently being displayed shows all the scans in the file. If you look at the 
bottom left corner of the screen the Start At: value is 0% and the Span: is 100% 
indicating that you are viewing the whole file. Notice also that the movement buttons 
on the button bar are all greyed out since you are viewing the whole file there is 
nowhere to move to.  
 
Adjust the span to 25% by clicking on the left arrow of the scroll bar below the 
Span: box. It is easier if you hold down the mouse button rather than repeatedly 
clicking. If you go passed 25, click on the right arrow button in the scroll bar to 
increase the span to 25%. Now, click on the re-draw button which is to the right of 
the Span: box. The screen will now show the first 25% of scans in the file . Also, 
three of the movement buttons on the button bar are available, click on the Next 
button. The screen will change to show the second 25% of scans in the file, note that 
the Start At: box shows 25 not 0. You can continue to move around the file using 
the movement buttons and by selecting different values for Start At: and Span:. 
Remember, when you change either the Start At: or the Span: value you have to 
click on the re-draw button to implement the changes.  
 
Enter a Start At: value of 75% and a Span: of 50% and click on the re-draw button. 
The screen is updated but the Span: value is changed to 25% which is the maximum 
value with a Start At: of 75%. Whenever impossible values are entered the Span: 
will be adjusted automatically by Recall. 
 
 
1.6.9.  Log axis 

When viewing multi trend and peak jump files you can switch between a logarithmic 
and a linear y-axis. On the settings bar click on the Log button and the display will 
change to show a three decade logarithmic y-axis and the four log range buttons on 
the settings bar are no longer greyed out. The range displayed is 1x10-9 to 10x10-7 
indicated by the values 1x10-9, 1x10-8 and 1x10-7 on the y-axis. Click on the Log Low 
Range Increase button (the first button to the right of the Log button) to change the 
display to show two decades 10-8 and 10-9. Now, click on the Log Low Range 
Decrease button (second button to the right of the Log button) to change the display 
back to three decades. Click on the button again to display ranges 10-6, 10-7, 10-8 and 
10-9 then click on it once more. The display will now show five decades 10-5 to 10-9 
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and the Log Low Range Decrease button will be greyed out since 10-5 is the lowest 
gain range and you cannot decrease the low range any further. 
 
Click on the Log High Range Increase button (third button to the right of the Log 
button) and notice the bottom value on the y-axis change from 1E-9 to 1E-10. Click 
the same button once more to display the 10-11 range, the button will be greyed out. 
You are now displaying the maximum seven decades, 10-5 through 10-11 (for a file 
created using the Faraday detector). 
 
 
1.6.10.  Creating your own library 

The library feature is very useful and we will go through the sequence of operations 
for creating your own library. More details of the library feature can be found in 
section 2.2.  Libraries of the manual. 
 
Click on the Close button on the button bar to close the multi trend file, you now 
have no files open ( if you have closed them). Open the recall.wbg file, click on View 
on the menu bar then click on Copy to Clipboard (notice Ctrl+C next to Copy to 
Clipboard) in the View menu. The current scan, scan 1 of 20 of file recall.wbg, will 
be copied onto the clipboard and this will form the first entry in our new library. 
Click on the Library button on the button bar to open the Library Manager dialog 
box. We want to create a new library so click on the New> button. The type of folder 
we want to create is a bar chart folder so click on the Live Barchart scan folder 
radio button (this should already be selected) then enter the name for the folder. We 
will call the folder TUTORIAL 1 so position the mouse pointer in the Folder Name 
box, the arrow will change to a cursor, then click. Type in the name TUTORIAL 1, 
or some other name if you prefer. We will end this section by deleting the folder 
anyway. When you have typed in the name click on the Ok button.  
 
After a short delay the name TUTORIAL 1 will be added to the Library list. At this 
point the library folder TUTORIAL 1 has been created but the scan on the clipboard 
has not been put into it. With TUTORIAL 1 highlighted, click on the Open button. 
You will notice that a new child window and a message box have been opened. Click 
on the Yes button in the message box and a dialog box will be opened. Type in some 
text to form the scan description then click on the Ok button. After a short delay the 
scan on the clipboard will appear in the empty child window with the description you 
wrote just above the scan data. 
 
Now, we will add a second scan to the new library folder TUTORIAL 1. You should 
have two child windows open in the Recall window, the top most one is the library 
window and the other is for the file recall.wbg. Make the recall.wbg the active 
window by either clicking on a visible part of it or click on Window on the menu bar 
then click on 1 RECALL.WBG in the Window menu. Use the movement keys to 
select scan 15 of 20 then press CTRL+C on the keyboard to copy scan 15 of 20 to 
the clipboard. Make the library window the active window by clicking on part of it 
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or selecting it from the Window menu. Now, click on Library (which is only 
available when a library window is active) and click on Paste in the Library menu. 
The Edit Library Entry dialog box will be displayed so type some text for the 
description and click on the Ok button. After a short pause the scan will appear in the 
Library window and you can use the movement buttons to change between the two 
scans you have in the TUTORIAL 1 library folder. Normally you will have a number 
of data files from which to take scans rather than just the one, recall.wbg, that we 
have here. 
 
To delete the TUTORIAL 1 library folder close the library window by clicking on 
the Close button on the button bar with the library window active. Click on the 
Library button on the button bar to open the Library Manager dialog box. Click on 
TUTORIAL 1 in the Library list to highlight it then, click on the Delete button. A 
warning box will be displayed, click on the Yes button. TUTORIAL 1 will be 
removed from the Library list in the Library Manager dialog box. Once it is deleted 
the data in the library folder cannot be retrieved but the original data in the 
recall.wbg file is still available. 
 
 
1.7.  Using help 
1.7.1.  About Recall 

To display the Help About window select Help | About Recall . . . from the menu 
bar. From the About window you can check which edition of Recall for Windows 
you have. The line below the application title Recall for Windows will either be; 
Standard Edition in which case you have all the features described in this manual 
or 
Analytical Edition in which case some of the advanced data analysis features are 
described in a supplemental manual, reference LP103017. 
 
Also in the About window will be the software version number. If you need to 
contact your local Spectra facility for help it is most important to have the software 
version number available. 
 
Operation of Help is fully describe in section 2.7.  Help. 
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Section 2. 
Technical Reference 
 
In this section of the manual we will describe each of the commands in Recall for 
Windows. We envisage users referring to this section when they require help on a 
specific topic, you may like to practise using Recall and then read parts of this 
section as necessary. 
 
 
2.1.  File commands 
To access any of the file commands click on File in the menu bar or press ALT+F to 
show the File menu. Click on the file command to carry out the command or open a 
dialog box. Some of the commands have short cut keys, some have buttons on the 
button bar. Each command is described below. 
 
 
2.1.1.  Opening a file 

To open a file select File | Open from the menu bar or press CTRL+O or click on 
the Open button on the button bar. A standard windows open file dialog box will be 
displayed, the various parts of which are described below. 
 
Once all the information is correct click on the OK button to open the file or click on 
the Cancel button to close the dialog box without any action being taken. 
 
File Name: Enter the name of the file you wish to open in the File Name box by 

typing the full name or clicking on one of the files in the file name 
list. 

 
Directories: This box will display a list of the directories on the currently 

selected drive. Use the directories box to select the directory where 
the file you wish to open is stored. 

 
Drives: Click on the Drives: dropdown list to display the drives available on 

your system then click on the required drive. 
 
List File of Type: 
 There are six file types available and these correspond to the six 

main modes in RGA for Windows. Each file type has its own file 
extension. Files of one type may be displayed in the file name list by 
clicking on the appropriate file type in the List File of Type: 
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dropdown list box. The file types with their extensions are listed 
below: 

   
 Multi Trend   .wmt 
 Analogue  .wan 
 Bar Chart  .wbg 
 Peak Jump  .wpj 
 Fast Scan  .wfs 
 Leak Check .wlc 
 
 In addition to the six file types selecting (*.*) will display all the 

files in the currently selected directory and selecting (*.w*) will 
display all the RGA for Windows files (and any other files with a 
file extension beginning with a w). 

 
 
 
2.1.2.  Multi head/valve files 

If the file you select to open was stored on a system running multi headed  
RGA for Windows software or on an instrument fitted with a Valve Controller the 
Select Head or Select Valve dialog box will be displayed. A file stored on an 
instrument fitted with a valve controller will consist of scans stored with the different 
valves open. The valve select function acts as a filter causing only those scans stored 
with the specified valve open to be displayed. The same is true for files stored on a 
multi headed RGA for Windows system. 
 
To open the file with all the scans available stored from different heads, or with 
different valves open, click on the All Valves / Heads radio button then click on the 
Ok button. 
 
To open a file showing only scans from one head or with one particular valve open 
click on the Selected Valve / Head radio button, enter the number of the head or 
valve in the Number: box, then click on the Ok button. 
 
A new scan window will be opened, the valve or head number will be shown in 
square brackets in the title bar. The number of scans shown below the title bar will 
be the number for the head or valve selected rather than the total number of scans in 
the file. The user may open another scan window for the same file to display scans 
stored from another head or with another valve open. 
 
 
 
 

2.1.3.  Closing a file 
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To close a file click on the Close button on the button bar or select File | Close from 
the menu bar. Only the currently active file will be closed, if other files are open they 
will remain open. 
 
 
2.1.4.  Browsing 

You can browse through the data files you have stored looking at file name, date, 
time and comment information to find a specific file before opening it. Select File | 
Browse . . . from the menu bar to open a standard windows open file dialog box. 
Enter information in the same as you would when opening a file, as described above. 
Click on the Ok button to open the Comment Browser window which will display 
the full file name, the date and time when the file was stored and the comment. Click 
on the Open button to open the file or click on the Browse button to select another 
file. 
 
 
2.1.5.  File log 

Due to the eight character limit on DOS filenames, giving meaningful names to data 
files can be difficult, particularly when you have a large number of files. The file log 
is designed to make opening one of a large number of files easier. 
 
One file log can be created and maintained for each disk directory. The file log 
contains four pieces of information for each data file: file name, date, time and 
comment. It is important to make use of the comment field to obtain the best 
advantage from the file log. 
 
 
2.1.5.1.  Opening a file log 
 
To open a file log select File | Open Log . . . from the menu bar or click on the Open 
Log button on the button bar or press CTRL+L. The Select a Directory window will 
be displayed. Choose the drive and directory for which you want the file log. Recall 
will maintain one File Log in each directory of your choice. For your information, a 
list of the data files in that directory will be displayed. Click on the Ok button to 
open the log. If no log exists you will be asked if you want Recall to create one. The 
file log will be opened and the Scan Log window will be displayed which is in the 
form of a four column table. The columns are: file name, the date when the file was 
stored, the time when the file was stored and the comment. 
 
To open a file from the file log click anywhere in the row for that file then click on 
the Open button or, double click anywhere on the row for that file. 
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2.1.5.2.  Maintaining the file log 
 
When you create the file log the files are sorted according to the file type, determined 
by the filename extension and then by the filename. The file log is not updated 
automatically as new files are added to the directory.  
To add new files to the file log after it has been created, updated or re-compiled 
select File | Update Log . . .  from the menu bar. The Select a Directory dialog box 
will be displayed. Select the drive and directory then click on the Ok button. The 
new files will be added to the end of the file log. 
 
Re-compiling the file log will re-create the file log with all the data files found in the 
specified directory. This has the advantage of sorting all the files so that files of the 
same type appear grouped together e.g. all the Bar Chart files appear together. It may 
take a little longer than simply updating the log. 
To re-compile the file log select File | [Re]-compile Log . . . from the menu bar, the 
Select a Directory dialog box will be displayed. Select the drive and directory then 
click on the Ok button. 
 
 
2.1.6.  Printing 

The Print command in Recall for Windows provides a good deal of flexibility and a 
range of features to enable the user to produce high quality and informative hard 
copies. 
 
To begin printing, select File | Print . . . from the menu bar or click on the Print 
button on the button bar or press CTRL+P. If you have not used the print command 
in this session the Font window will be displayed, otherwise the Print Layout 
window will be displayed. 
 
In the Font window select the required Font:, Font Style and Size: you will be able 
to see what your choice looks like in the Sample box. Recall only uses the font name 
from the Font window the font style and size are ignored, although the setting does 
affect the appearance of your choice in the Sample box. The font size is set by 
clicking on the Fonts>> button in the Print Layout window. When you have finished 
click on the OK button and the Print Layout window will be displayed. Note that the 
number and type of fonts available will depend on the printer and printer driver you 
have selected from Windows Program Manager | Control Panel | Printers.  
 
The various settings available in the Print Layout window are described below. Once 
any required changes have been made click on the Print button to start printing, click 
on the Cancel button to close the Print Layout window, and throw away any changes 
you have made. 
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2.1.6.1.  Print layout window 
 
There are two areas at the top of each printout where title information can be shown; 
in the centre and to the right. Type in the appropriate box the text you want to appear 
in the title, you may include the & characters as described below and alter the fonts 
by using the Fonts>> button, again described below.  
By default the centre title will contain the application title Recall for Windows and 
the filename by including the &A and &F characters. The right title will contain the 
time and date when the file was stored by incorporating the &D and &T characters. 
The default information can be removed simply by deleting the & characters using 
the DELETE and BACKSPACE keys. 
A maximum of four lines of text may be printed as a title. The first line forms the 
Heading and the remaining three the Sub-Heading. The scroll bars should be used to 
view titles which are too large to fit in the boxes. 
 
A footnote may be printed below the scan data on the printout. Type in the text for 
the footnote in the Footnote box, the & characters may be used and the font for the 
footnote can be changed by using the Fonts>> button. 
 
You can include on the printout the comment that was stored as part of the data file 
by clicking on the Options, Print Comment check box to check it. The comment 
may be printed immediately above the scan data, to do this click on the Above scan 
radio button. To print the comment at the bottom of the page just above the footnote 
click on the Below scan radio button. Space for the comment is limited on the 
printout, if it is very long choose a small font. See below for details of changing font 
sizes. 
 
There are a number of special features which apply to printing files stored in the 
Multi-Trend, Leak Check and Fast Scan modes. To print the traces just as black lines 
click on the Unlabelled Mono radio button in the Trends box. To add the channel 
number as a label to the appropriate trace click on the Labelled Mono radio button. 
Be warned, this may considerably increase the time taken to print. If you have a 
colour printer you can print coloured traces by clicking on the Colour radio button in 
the Trends box.  
 
The printout can be in a landscape or portrait orientation as shown in the Layout box. 
To change the orientation click on the Setup>> button then click on the appropriate 
radio button in the Orientation section of the Print Setup window. 
The printout can be positioned centrally on the page by checking the Central on 
Page check box. If this is not checked the printout will be offset on the page to leave 
a wide margin on the left of a portrait printout and at the top of a landscape printout 
to allow printouts to fit into a binder. 
 
To change the type or size of font used on the printout click on the Fonts>> button to 
display the Font Sizes window. Only one type of font may be used throughout the 
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printout but this may be changed by clicking on the Change Font button to display 
the Font window and then select the required font. The current font is shown 
immediately above the Change Font button. The size of characters in various parts 
of the printout may be changed by clicking on the appropriate dropdown list box then 
clicking on the required size in the list. The Main Heading is the first line of text 
written in the Centre Title box or the Right Title box. If you only want Main Heading 
text in the Center, put a blank line as the first line in the Right Title box. The Sub 
Heading is the remainder of the text written in the Centre Title box and the Right 
Title box. When all the information is correct click on the Ok button, clicking on the 
Cancel button will close the Font Sizes window without any changes being made to 
the fonts. 
 
 
2.1.6.2.  & Characters 
 
Certain information can automatically be added to titles and footnotes by the use of 
the & characters. Their functions are described below: 
 
&A prints the Application title, Recall for Windows 
&C prints the full scan Caption as displayed on the button bar 
&D prints the scan Date 
&F prints the Filename as displayed in the window title 
&I prints the library scan description (Information) 
&N prints the current date, when the printout is printed (Now) 
&S prints the Scan number if applicable 
&T prints the scan Time 
&U prints the literature library scan formUla 
&& prints a single & character 
 
This list can be displayed on screen by clicking on the Help button in the Print 
Layout window.  
 
 
2.1.6.3.  Print defaults 
 
Once you have setup the format for your printout it is likely you will want to use it 
again or keep it as your standard print layout. You can do this by clicking on the 
Save Settings as Default button which will save the current setup for future use. 
 
 
2.1.7.  Show as . . . 

2.1.7.1.  Show as trend 
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The Show As Trend menu item is available when the active window contains a Peak 
Jump or Bar Chart file. A Peak Jump file will be converted to a Multi Trend display  
with the channels set to the same masses. The Peak Jump file must contain at least 
two scans. A Bar Chart file will be displayed as a Multi Trend with the channels set 
to masses defined in File | Defaults | Bar to trend conversion, see section 2.1.9.3.  
Bar to trend conversion. Once the trend is displayed the channels may be set to any 
mass within the range of masses stored in the original Bar Chart file. To display a 
Peak Jump or Bar Chart file as a Multi-Trend select File | Show As Trend from the 
menu bar, a new window will be opened containing the trend display. 
 
 
2.1.7.2.  Show as peak jump 
 
A Multi Trend, Fast Scan or Leak Check file may be displayed as a Peak Jump by 
selecting File | Show As Peak Jump from the menu bar. Another window will be 
opened containing the Peak Jump display and the usual functions are available to 
move through the scans. 
 
 
2.1.8.  Scan clipboard 

You can open a child window whose function is to display the contents of the 
clipboard. No other information may be displayed in this window. To open the Scan 
Clipboard window select File | Scan Clipboard from the menu bar. If there is a scan 
on the clipboard it will be displayed, if there is not the message “Clipboard is empty” 
will be displayed. A check mark ( ) will be shown next to Scan Clipboard in the 
File menu when the Scan Clipboard window is open. Selecting File | Scan 
Clipboard from the menu bar when the check mark is displayed will cause the 
window to be closed. 
 
When the Scan Clipboard window is the active window five extra menu items are 
available in the View menu, as described in section 2.4.  View commands. 
 
Only Bar Chart, Peak Jump and Literature scans can be displayed in the Scan 
Clipboard window. Multi Trend, Fast Scan and Leak Check scans copied to the 
clipboard using View | Copy to Clipboard will be shown as a Peak Jump. It is only 
the final displayed set of data points which are copied onto the clipboard and, 
therefore, shown as the Peak Jump. Before copying data to the clipboard, be sure to 
adjust the span of the trend so that the required data is at the end of the display. 
 
The Scan Clipboard window is not automatically updated as the contents of the 
clipboard change. 
 
 
2.1.9.  Defaults 
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The default settings generally determine the initial appearance of scan windows. All 
the settings are adjusted in the Recall Default Settings window which is opened by 
selecting File | Defaults . . . from the menu bar. 
 
The settings in the centre of the window are determined by which of the four options 
in the top part of the window are selected. 
 
Once all the settings are correct click on the Ok button to use them for this session of 
Recall. Click on the Save These Settings as Default button if you want to use these 
settings each time you use Recall for Windows. Clicking on the Cancel button will 
close the Defaults Settings window without any changes being implemented.  
 
 
2.1.9.1.  General view options 
 
To change the general view options click on the General View Options radio button 
or press ALT+G. 
 
X-axis Title Enter the title to appear under the X-axis. The factory default setting 

is Mass (a.m.u.). Do not enter a title longer than the space provided 
in the box. 

 
Y-axis Title Enter the title to appear next to the y-axis. The factory default 

setting is Pressure (mBar). Do not enter a title longer than the space 
provided in the box. 

 
Show Y-axis Title 
 When this box is checked the y-axis title will be displayed. Un-check 

this box and the y-axis title will be hidden and the y-axis will move 
to the left to use the additional screen space. 

 
Cursor Click on the Cursor box to check it and have the cursor enabled 

when you open a file. 
 
Grid Click on the Grid box to check it and have the grid enabled when 

you open a file. 
 
 
2.1.9.2.  Peak jump and trend options 
 
To change the Peak Jump and Trend options click on the Peak Jump and Trend 
Options radio button or press ALT+P. 
 
Peak Surround  Click on the Peak Surround check box to enable the Peak Surround 

when a peak jump file is opened. 
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Alarms Click on the Alarms check box to enable the alarms display when a 

peak jump file is opened. 
 
Trend X-axis Text 
 With Multi-Trend, Leak Check and Fast Scan files the time on the x-

axis may be displayed vertically or horizontally by clicking on the 
Vertical or Horizontal radio button. 

 
Trend X-axis Time 
 With Multi-Trend, Leak Check and Fast Scan files the time may be 

displayed as actual time by clicking on the Real Time radio button 
or as elapsed time from the start of the scan by clicking on the 
Relative Time radio button. 

 
Continuous Trace 
 Check the Continuous Trace check box to display all the traces as 

solid lines. Un-checked the box to display each trace as a series of 
dots. 

 
 
2.1.9.3.  Bar to trend conversion 
 
Bar Chart files may be converted and displayed as a Trend. Since the Bar Chart file 
can contain up to 300 partial pressure measurements (if the mass range was 1 to 300 
amu) and the Trend can only display a maximum of twelve values, some method of 
determining which masses are initially displayed is required. The settings in the Bar 
to Trend Conversion window will determine to which masses the twelve channels are 
set. Selecting Use standard values will set channels 1 to 12 to the following masses: 
 2, 4, 12, 14, 15, 16, 17, 18, 28, 32, 44, 46 
 
If you select Use values from RGA4WINn.INI the channel masses will be the same 
as those last used in RGA for Windows as these settings are stored in the 
RGA4WINn.INI file. You must start Recall using the /h switch, so for instance, if 
you want to use the settings from the RGA4WIN3.INI file Recall should be started 
with a /h3 switch. 
 
Lastly, you may set your own masses by selecting Custom values. The mass for 
channel 1 will be displayed, type in the value you require then click on the right 
arrow button and set the mass for channel 2. Continue in this way until all the 
channels are set to the correct masses. You can click on the left arrow button to move 
backwards through the channels. 
 
Remember that once the Bar Chart to Trend conversion has taken place the mass 
setting for each channel may be changed. The above only determines the initial 
setting. If the file stored Total Pressure you can choose Total for any channel. 
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2.1.9.4.  Library 
 
This sets the default library which will be entered initially when File | Library . . . is 
selected from the menu bar. The default setting is SPECTRA which is the library 
supplied on the Recall for Windows program disks and is installed with Recall. To 
change the default library position the cursor in the Default Library Filename box 
and type in the new name. If the file is not to be placed in the Recall directory, you 
must specify the full path name. 
 
You may also change the label on the y-axis for scans in the literature folder. The 
default setting is Peak Height, to change this position the cursor in the Literature 
library Y-axis Title box and type in the new title. 
 
 
2.1.10.  Exiting Recall 

To exit Recall for Windows select File | Exit Recall from the menu bar or double 
click on the Control-menu box (the box with the minus sign in the top left corner of 
the main Recall window), see your Windows manual for further details.   
 
 
2.2.  Libraries 
The library is a powerful Recall feature which allows the user to store and retrieve 
historical data. Usually you would store your most important or interesting results in 
a library where they can easily be retrieved to view. Once scans are stored in a 
library there are a number of ways of organising the data. 
 
There is no limit to the number of libraries you can create although to begin with it is 
a good idea to just work with one library until you become familiar with the feature. 
Each Recall for Windows library is a single, Microsoft Access compatible disk file, 
stored with the filename extension .MDB.  
 
You can have any number of folders within each library. In turn each folder may 
contain any number of the same type of scans. There are three types of folder; folders 
which contain Bar Chart scans, folder that contain Peak Jump scans and folders that 
contain literature data (similar to the library data in RGA for Windows). So, for 
example, a library might contain three different Bar Chart folders, two Peak Jump 
and one Literature folder. Recall provides all the tools to move data from one folder 
to another or even one library to another. The nature of your work and how you wish 
to organise your results will determine the number of libraries and folders you will 
want to open. Since, you can move data around it is not necessary to determine this 
before you start to explore the feature or store data in libraries. 
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Data stored in a library is copied from its original source, the original data is not lost 
or erased. Storing data in a library is not necessarily a more compact method of 
storage. 
 
 
2.2.1.  The Spectra library 

Supplied with Recall for Windows is the Spectra library which will have been copied 
into the Spectra directory during the installation procedure. Using the default settings 
the full filename is: 
   C:\SPECTRA\SPECTRA.MDB. 
The spectra library contains one folder which is a literature scan folder containing 61 
entries. The 61 scans are fingerprints for common gases which are often encountered 
in gas analysis and vacuum systems. 
 
 
2.2.2.  Library manager 

The library manager is the main means of using and organising your libraries and 
their folders. From the library manager you can create, open and delete folders, open 
libraries or use the utilities to compact and repair the database.  
 
To open the library manager select File | Library . . .  from the menu bar or click on 
the Library button on the button bar. The Library Manager dialog box will be 
opened. 
 
The current library which is in use is shown in the Current Library File: box at the 
bottom of the dialog box. When you first enter the library manager the default library 
will be displayed: 
  C:\SPECTRA\SPECTRA.MDB 
 
providing you installed Recall for Windows in the default directory and have not 
changed the library default using File | Defaults . . . , refer to section 2.1.9.4.  
Library. The Library box will contain a list of all the folders in the currently 
selected library (SPECTRA.MDB). Initially there will be just one listed, RGA.  
 
To open a folder click on the required name in the list to highlight it, then click on the 
Open button. 
 
To create a new folder click on the New> button to display the Library Folder dialog 
box. 
 
You can delete a folder by highlighting it then clicking on the Delete button, a 
warning box is then displayed, click on the Yes button to complete the deletion. Once 
a folder has been deleted the data in it will be lost, IT IS NOT RECOVERABLE. 
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To change to another library or to create a new library click on the Change button to 
open a standard windows open file dialog box. 
 
Click on the Utilities> button to display two more options Compact Database and 
Repair Database, these are described later. 
 
To close the Library Manager dialog box, click on the Cancel button or press ESC. 
 
 
2.2.3.  Creating a new library 

To create a new library select File | Library . . . from the menu bar or click on the 
Library button on the button bar to open the Library Manager dialog box, then click 
on the Change button. A standard Windows open file type dialog box will be 
displayed. Enter the name for the new library in the File Name: box do not include a 
filename extension Recall automatically supplies the .MDB extension. A warning 
box will then be displayed to tell you Recall cannot find the library and do you want 
to create a new one, click on the Yes button. Another warning box will then be 
displayed asking you if you want to create any folders in the new library. If you click 
on the Yes button the Library Folder dialog box will be displayed. Then, follow the 
procedure described in section  
 
2.2.4.  Opening and creating folders.   

Click on the No button to create the library with no folders in it, you can add folders 
later. Another warning box will be displayed to give the user another chance to create 
folders, click on the No button. The Library Manager dialog box will then be 
displayed. 
 
2.2.4.  Opening and creating folders 

To open a folder: select File | Library . . . from the menu bar or click on the Library 
button on the button bar to open the Library Manager dialog box, click on the 
required folder name in the Library list box to highlight it then click on the Open 
button. Note that you can open a folder more than once, in this way you can view 
different scans in the same folder simultaneously. 
 
To create a new folder: select File | Library . . . or click on the Library button on the 
button bar to open the Library Manager dialog box, click on the New> button to open 
the Library Folder dialog box. Click on one of the three folder types, enter a name for 
the folder in the Folder Name box then click on the Ok button. If you create a 
literature scans folder you will be asked if you want to include a standard literature 
library which will store in the folder 61 scans showing spectra of the most common 
gases and vapours found in vacuum systems. 
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2.2.4.1.  Folder types 
 
There are three types of folder which contain different types of scans. A Bar Chart 
folder, unsurprisingly, contains Bar Chart scans but can also contain Analogue scans 
which will be converted to Bar Chart scans. Peak Jump folders primarily store Peak 
Jump scans but may also store Multi Trend, Fast Scan and Leak Check data. In each 
case it is the last displayed scan in the trend that is stored in the library folder as a 
Peak Jump scan. The third type of folder is the literature scan folder where scans 
consist of spectra data where peaks are given intensities in the range 0 to 1000 by the 
user. The user effectively “designs” his own spectra by “drawing” peaks. Usually the 
user will use proprietary libraries of spectra as a source of information for the 
literature scan folder. 
 
 
2.2.5.  Populating a library folder 

Once you have created a library and have opened a folder you will then want to 
begin filling it with scans. This is done by copying onto the clipboard scans from 
data files then pasting them into the library folder. 
 
Firstly, open the file containing the scan you want to put into the library by clicking 
on the Open button or selecting File | Open from the menu bar and selecting the file 
from the Open dialog box. Assuming the file contains more than one scan select the 
required scan using the Goto commands or buttons as described in section 2.3.  Goto 
commands. Now, copy the scan to the clipboard by selecting View | Copy to 
Clipboard from the menu bar or press CTRL+C. You can close the file or leave it 
open; it makes no difference once the scan is on the clipboard. Open the library 
folder by selecting File | Library . . .  from the menu bar or clicking on the Library 
button to display the Library Manager dialog box. Change to the required library if 
necessary then open the folder. If the folder already contains one or more scans a 
child window showing the first scan in the folder will be displayed. Select Library | 
Paste from the menu bar or press CTRL+V. The Edit Library Entry window will be 
displayed, enter a description for the scan then click on the Ok button. 
 
If the folder doesn’t contain any scans a warning box will be displayed which will 
tell you that there is a scan on the clipboard and ask you if you want to paste it into 
the folder, click on the Yes button. 
 
 
2.2.6.  Finding scans 

The Goto commands operate in the same way with library folders as they do with 
ordinary Recall data files. You can display different scans by using the movement 
buttons on the button bar or by selecting the Goto commands from the menu bar, as 
described in section 2.3.  Goto commands. The Scan Number command does 
operate slightly differently when used with library folders, as described below. 
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2.2.6.1.  Scan number 
 
You can jump to another scan from the active folder by defining text to search for in 
the scan description. Select Goto | Entry . . . from the menu bar or press Shift+F9 or 
click on the Scan Number button on the button bar to display the Find a Folder Entry 
dialog box. In the Scan Description to search for: box enter the text for Recall to 
use for the search. It is a good idea to just enter the first one or two letters of the 
description. Wild cards may not be used. Click on the Find First button to display 
the first scan in the folder whose description matches the search text. Click on the 
Find Next button to display the next scan in the folder which matches the search 
criterion. If you want to find records that contain a certain phrase you should use the 
Search/Sort command in the Library menu. 
 
 
2.2.7.  Library menu 

When you open a new folder a new child window will be opened showing the first 
scan in the folder. Also, the Library menu will be added the menu bar, the Library 
menu is not shown at other times. The library menu commands are described below. 
 
 
2.2.7.1.  Select/sort 
 
When you open a library folder all the scans in that folder are available. At first you 
will probably only have a few scans in each folder and it will be quite easy to look 
through them using the movement buttons or the Goto commands. As your folders 
grow in size it is useful to work with a subset of the scans. The select/sort command 
allows you to form a subset of scans based on a selection criterion which you specify. 
Once you have the subset the movement buttons and Goto commands work in the 
same way but just on the subset rather than the whole folder.   
 
To create a subset of scans select Library | Select/Sort . . .  from the menu bar and 
the Current Search and Sort Criterion dialog box will be displayed. The Selection 
Criterion: box will describe the current selection criterion, if this is too large to fit in 
the box use the scroll bar. Initially the search criterion is set to select all scans from 
the folder. If you want to use the current criterion click on the Run Search button. If 
you want to alter the criterion or create a new search criterion click on the Rebuild 
Query button and the Construct a Search and Sort Criterion dialog box will be 
displayed. 
 
You build a selection criterion by using the elements in the Selection part of the 
dialog box. Select a field name from the Field Name: dropdown list, a comparison 
from the Operator dropdown list then, enter a value in the Value box. Add the 
criterion to the selection criterion by clicking either the And Into Selection or Or 
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Into Selection button depending on which logic operation you want to be performed. 
You can then carry on to add further criteria to the selection by repeating the above 
until you have the desired criterion when you click on the Run Search button to 
carry out the selection procedure. 
 
As you build up multiple criteria, Recall adds brackets to the statement to resolve the 
logical priorities of And/Or. If the sense is not what you require you can edit the 
brackets by  changing the text in the Criterion box. The order of the brackets is in 
some circumstances dependant on whether you choose And or Or as your first 
selection. For more information see Online Help. 
 
You can also define the criterion by which the scans in the subset are arranged by 
selecting one or more items from the Sort By list. Click on the item you want to sort 
by first so that it is highlighted then, click on the next item you wish to sort by, and 
so on. You may select as may items from the Sort By list as you like and the order in 
which the sorting is done is determined by the order in which you select the items 
from the list. To de-select an item simply click on it so that it is no longer 
highlighted. To de-select all the items click on the Clear button. 
 
 
2.2.7.2.  Select all 
 
If you have used the select/sort command as describe in section 2.2.7.1.  Select/sort, 
then only a subset of scans will be available to you rather than all of the scans in the 
active folder. If you want to make all the scans available again select Library | 
Select All from the menu bar. 
 
 
2.2.7.3.  Edit 
 
The description is the text shown immediately below the settings bar which was first 
entered when the scan was copied into the library folder. Edit allows you to modify 
this scan description. It also allows changes to be made to literature scans folders. 
 
Select Library | Edit . . . from the menu bar to display the Edit Library Entry dialog 
box. Enter the new text or modify the existing text then click on the Ok button. 
Clicking on the Cancel button will close the dialog box without any changes being 
made. If the active folder is a literature scans folder the Literature Library Folder 
Data Entry dialog box will be displayed. The title and values may be changed by 
following the details in section 2.2.7.4.  Add . 
 
 
2.2.7.4.  Add 
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The add command is used to add scans to a literature scans folder and is only 
available when a literature scan folder is active. Select Library | Add . . . from the 
menu bar and the Literature Library Folder Data Entry dialog box will be displayed. 
In the title section, type the name for the entry in the Name: box and its formula in 
the Formula: box. You do not have to enter a formula. The next step is to enter a 
value in the range 1 to 1000 for up to 15 peaks which will make up the spectra. 
Usually, the major peak is given the value 1000 with up to 14 minor peaks being 
given values relative to this.  
 
Position the cursor in the Mass: box and enter the mass of the major peak then, 
position the cursor in the Value: box and enter a value in the range 1 to 1000 
(usually 1000 for the major peak) then click on the Insert button. Enter the mass for 
the second peak, then enter a value and click on the Insert button. Continue in this 
way until all the required peaks have been entered. If you make a mistake while 
entering a Mass or its Value click on the Undo button to clear it and start again.  
 
Once you have some entries in the Table of Values you can click on one to highlight 
it. If you now click on the Delete button it will be removed from the list. Once an 
entry is highlighted its mass and value will be shown in the Mass: and Value: boxes 
where they may be modified then, click on the Change button to add the modified 
values to the Table of Values. 
 
You may type text in the Comment box which will be displayed in the Recall (Scan 
Info) window.  
 
When all the information is correct click on the Add button to add the new entry to 
the folder and clear the dialog box ready for your next entry. Click on the Done 
button when you have finished to close the dialog box. 
 
 
2.2.7.5.  Paste 
 
The paste command is used to copy scans from the clipboard into bar chart and peak 
jump folders. To paste a scan into a folder make sure the folder is the active folder, 
select Library | Paste from the menu bar or press CTRL+V. Paste will be greyed 
out in the library menu list if there is no scan on the clipboard. The Edit Library 
Entry dialog box will be displayed, type in the text for the description then, click on 
the Ok button. The new scan will be added to the end of the folder. If you have a sort 
criterion it is unlikely that the new scan will be in the correct place so, use the 
Refresh command  to re-sort the folder. 
 
If you are running RGA for Windows, you can copy the live scan to the clipboard 
and Paste it directly into your library in Recall. 
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2.2.7.6.  Paste merge 
 
The paste merge command allows a scan placed on the clipboard to be merged with 
the active scan. This feature was originally designed so that a scan taken using the 
multiplier detector could be combined with a scan taken using the faraday detector to 
provide a combined Bar Chart scan. Paste merge is only available when the current 
folder is a Bar Chart folder. Bar Chart and Peak Jump scans may be merged from the 
clipboard into a Bar Chart scan. Care should be taken as the resulting scan will be a 
composite and will only be authentic if you plan in advance what separate 
information you require. 
 
Paste merge will be greyed out in the Library menu if the clipboard is empty. 
Before using paste merge make sure the active folder is a Bar Chart folder and the 
scan you want to merge has been copied on to the clipboard. Select Library | Paste 
Merge from the menu bar, the Paste Merge dialog box will be displayed. 
    
The scan on the clipboard may be scaled when it is merged into the active scan. In 
the Pasted-In Peak Height Compensation area of the Paste Merge dialog box click on 
the Total Pressure radio button to apply a scaling factor to all the partial pressures 
and total pressure such that the total pressure of the scan on the clipboard and the 
total pressure of the active scan will be equal. For example, suppose the active scan 
has a total pressure of 4x10-7 and the scan on the clipboard has a total pressure of 
2x10-7. The total pressure and all the partial pressures of the clipboard scan will be 
multiplied by 2 before being merged, since, 2x10-7 * 2 =  4x10-7. Of course, this 
will only work if there is a total pressure reading with each of the scans. 
 
Rather than scaling using the total pressure you can use a partial pressure. If you 
click on the Partial Pressure of mass radio button and enter a mass in the box the scan 
on the clipboard will be scaled so that the partial pressure of the mass specified is the 
same as that in the active scan. You must choose a mass that has a valid partial 
pressure in both scans.  
 
Click on the None radio button to apply no peak height compensation. 
 
When the scan on the clipboard is pasted into the active scan there are likely to be 
conflicts where both scans have a value of partial pressure for a certain mass. An 
order of priority can be established by using the settings in the Priority area of the 
Paste Merge dialog box. Click on the Multiplier readings over Faraday check box 
to check it, then the value obtained using the multiplier detector will be used rather 
than the faraday value. This will only be of use if one scan was obtained with the 
multiplier and the other with the faraday detector. Check the Pasted-in readings 
check box and the partial pressures in the scan on the clipboard will be used rather 
than those in the active scan. 
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Suppose you have a faraday scan in the Scan Clipboard window and a multiplier scan 
on the clipboard. The faraday scan is in the range E-6 to E-10 and the multiplier scan is 
in the range E-8 to E-12. The final resultant scan will be in the range E-6 to E-12. The 
faraday scan may have some peaks around 0.5xE-10 or less, which may be due to 
noise rather than real partial pressures. In the final resultant scan such peaks will 
appear as 5xE-11 peaks. Checking Delete peaks not currently displayed sets all Scan 
Clipboard window peaks less than 1xE-(max gain range) to zero. 
 
When you have configured the settings in the Paste Merge dialog box, click on the 
Merge Overwrite button to carryout the merge operation and overwrite the active 
scan with the result. If you click on the Merge Into New Copy button a new scan 
will be created and the active scan will be retained, unchanged. The Edit Library 
Entry dialog box will be displayed, enter new text for the description and click on the 
Ok button to carry out the merge operation. 
 
 
2.2.7.7.  Delete 
 
To remove the currently active scan from the library folder select Library | Delete 
from the menu bar. A warning box will be displayed, click on the Yes button to 
delete the scan. Once the scan is deleted from the folder it cannot be retrieved. 
 
 
2.2.7.8.  Cut 
 
The cut command removes the active scan from the library folder and places it on the 
clipboard. Primarily this is used to move scans between libraries and folders. To cut 
a scan select Library | Cut from the menu bar, a warning box will be displayed, 
click on the Yes button to cut the scan from the folder.  
 
 
2.2.7.9.  Info 
 
Select Library | Info from the menu bar or click on the Info button on the settings 
bar to display the Library Info window. This gives details of the current 
selection/sort criterion and the number of records in the currently selected folder. 
Click on the OK button to close the window. 
 
 
2.2.7.10.  Refresh 
 
Select Library | Refresh from the menu bar or press F4 to re-draw the active library 
scan and sort the folder based on the current criterion. It is sometimes necessary to do 
this after making changes to folder entries or adding new scans to a folder. 
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2.2.7.11.  Utilities 
 
There will be times when you will want to carry out operations on a number of scans 
in a library folder. The scanset utilities command allows you to copy, move and 
delete a number of scans at the same time. Scanset utilities could be usefully used 
when a folder has become very large and you want to archive some of the scans into 
another folder. It is important to remember that the scanset utilities commands 
operate on the current scanset which maybe the whole folder or more likely a subset 
of scans generated by using the Select/Sort command. For example, if you are 
archiving off some old scans you would first use the select/sort with a criterion of; 
Date/Time < 31/12/94 say, to select scans stored in 1994 and before. 
 
To use the scanset utilities select Library | Scanset Utilities from the menu bar and 
a menu list containing three menu items will be displayed. To delete all the scans in 
the current scanset click on Delete All . . . , a warning box will be displayed click on 
the Yes button to carry out the deletion. Once the scans have been deleted they 
cannot be retrieved. 
 
To copy the scans in the current scanset select Copy All . . . from the menu list and 
the Select A Destination Library dialog box will be displayed. This is a standard 
windows open file type dialog box, select the library where the scans will be copied 
to. This maybe the same library if you are just copying to a different folder or it 
maybe a different library. The Select A Destination Folder dialog box will be 
displayed, click on the desired folder to highlight it then click on the Copy button. If 
you want to create a new folder to copy the scans to click on the New>> button, enter 
the name for the new folder, then click on the Copy button.  
 
To move the scans in the current scanset select Move All . . . from the menu list and 
the Select A Destination Library dialog box will be displayed. This is a standard 
windows open file type dialog box, select the library where the scans will be moved 
to. This maybe the same library if you are just moving the scans to a different folder 
or it maybe a different library. The Select A Destination Folder dialog box will be 
displayed, click on the desired folder to highlight it then click on the Move button. If 
you want to create a new folder to move the scans to click on the New>> button, 
enter the name for the new folder, then click on the Move button.  
 
Remember to backup your .MDB and .LDB files regularly. Libraries contain large 
amounts of data in just one place. If anything happens to that file, all your data may 
be corrupted. 
 
 
2.3.  Goto commands 
The Goto commands enable you to view scans within a data file. Each command is 
available in the Goto command list which is displayed by clicking on Goto in the 
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menu bar or pressing by ALT+G. Each of the seven commands are available by 
clicking on the appropriate button on the button bar or pressing the shortcut key. If a 
data file contains only one scan then all the Goto commands (and their buttons) will 
be greyed out. 
 
 
2.3.1.  Next 

With Bar Chart, Analogue and Peak Jump files goto the next scan in the file by; 
selecting Goto | Next Scan from the menu bar or clicking on the Next button on the 
button bar or pressing F7. If you are viewing the last scan in the file this command 
will be greyed out. 
 
With Multi Trend, Fast Scan and Leak Check files where more than one scan is 
displayed goto to the next page of scans by; selecting Goto | Next Page from the 
menu bar or clicking on the Next button or pressing F7. If you are viewing the last 
page this command will be greyed out. 
 
 
2.3.2.  Previous 

With Bar Chart, Analogue and Peak Jump files goto the previous scan in the file by; 
selecting Goto | Previous Scan from the menu bar or clicking on the Previous button 
on the button bar or pressing F6. If you are viewing the first scan in the file this 
command will be greyed out. 
 
With Multi Trend, Fast Scan and Leak Check files where more than one scan is 
displayed goto the previous page of scans by; selecting Goto | Previous Page from 
the menu bar or clicking the Previous button on the button bar or pressing F6. If you 
are viewing the first page of scans this command will be greyed out. 
 

2.3.3.  Jump forward 

With Bar Chart, Analogue and Peak Jump files to jump forward by approximately 
10% of the total number of scans in the file select Goto | Jump Forward from the 
menu bar or click on the Jump Forward button on the button bar or press SHIFT+F7. 
If you are already viewing the last scan in the file this command will be greyed out. 
 
With Multi Trend, Fast Scan and Leak Check files where more than one scan is 
displayed jump forward by approximately 10% of the total number of pages by; 
selecting Goto | Jump Forward from the menu bar or clicking the Jump Forward 
button on the button bar or pressing SHIFT+F7. If you are already viewing the  last 
page of scans this command will be greyed out. 
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2.3.4.  Jump Backward 

With Bar Chart, Analogue and Peak Jump files to jump backward by approximately 
10% of the total number of scans in the file select Goto | Jump Backward from the 
menu bar or click on the Jump Backward button on the button bar or press 
SHIFT+F6. If you are already viewing the first scan this command will be greyed 
out. 
 
With Multi Trend, Fast Scan and Leak Check files where more than one scan is 
displayed jump backward by approximately 10% of the total number of pages by: 
selecting Goto | Jump Backward from the menu bar or clicking on the Jump 
Backward button on the button bar or pressing SHIFT+F6. If you are already 
viewing the first page of scans this command will be greyed out.  
 
 
2.3.5.  Last 

With Bar Chart, Analogue and Peak Jump files to goto the last scan in the file either; 
select Goto | Last Scan from the menu bar or click on the Last button on the button 
bar or press F8. If you are already viewing the last scan in the file this command will 
be greyed out. 
 
With Multi Trend, Fast Scan and Leak Check files where more than one scan is 
displayed view the last page of scans by; selecting Goto | Last Page from the menu 
bar or click on the Last button on the button bar or press F8. If you are already 
viewing the last page of scans this command will be greyed out. 
 
 
2.3.6.  First 

With Bar Chart, Analogue and Peak Jump files goto the first scan in the file by; 
selecting Goto | First Scan from the menu bar or clicking on the First button on the 
button bar or pressing F5. If you are already viewing the first scan this command will 
be greyed out. 
 
With Multi Trend, Fast Scan and Leak Check files where more than one scan is 
displayed view the first page of scans by; selecting Goto | First Page from the menu 
bar or click on the First button on the button bar or press F8. If you are already 
viewing the first page of scans this command will be greyed out. 
 
 
2.3.7.  Scan Number 

With Bar Chart, Analogue and Peak Jump files the user can select a specific scan for 
display by entering the scan number in the Goto Scan Number dialog box which is 
displayed by selecting Goto | Scan Number . . . from the menu bar or by clicking on 



 

Recall Manual 
LP101006 Rev 2.10   Nov. 2000 Page 22 

the Goto button or by pressing F9. Enter the required number by clicking on the up 
or down arrow or by typing in the value, the maximum and minimum values are 
displayed. Then, click on the Ok button. 
 
When you are viewing library scans you enter the first few letters of the scan 
description rather than the number, as described in section 2.2.6.1.  Scan number. 
 
2.3.8.  Span settings 

For files stored in Multi-Trend, Fast Scan and Leak Check modes the number of 
scans displayed on the screen may be changed. In this way the whole scan may be 
viewed to see the overall trend or a small section may be zoomed in on to see details 
of pressure changes. When you first open the file the whole scan will be displayed. 
For very long files Recall will still display the whole file but the data may be 
compressed. Normally the PC screen can display approximately 1000 individual data 
acquisitions. 
 
Two controls are provided to display parts of the file. The Start At: control 
determines the point in the data to use as the first scan displayed on the screen. The 
Start At: value is expressed as a percentage of the total number of scans in the file. 
For example, if the file contains 500 scans and the Start At: value is 10 the first scan 
will be scan number 50, from 500 x 10% = 50. 
 
The second control is the Span: setting which determines how many scans are 
displayed on the screen. Again, this is expressed as a percentage of the total number 
of scans. 
 
Both the Start At: and Span: controls are below the scan data and values may be 
entered by positioning the cursor in the box and typing the desired value. 
Alternatively, you can use the scroll bar to increment or decrement the value by 
clicking on the right or left arrow buttons or, drag the scroll bar using the mouse. 
 
The maximum Start At: value and minimum Span: value are displayed in brackets 
above the scroll bar. It is possible to enter values which cannot be used, for instance, 
a Start At: of 50 and Span: of 75. In these cases the Span: value will be adjusted to 
the nearest valid value by Recall for Windows. In the example the Span: setting 
would be changed from 75 to 50.  
 
Once new values for Start At: and Span: have been entered the screen needs to be 
re-drawn. To do this click on the Redraw button to the right of the scroll bars or 
select View | Redraw from the menu bar or press F4. 
 
 
2.4.  View commands 
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The view commands change the way the data is presented on screen they do not 
change the data itself. 
 
 
 
2.4.1.  Y-axis 

The y-axis command controls the scale displayed on the pressure axis. For Multi-
Trend, Peak Jump and Fast Scan files you switch between a logarithmic and linear y-
axis by clicking on the Log button on the settings bar or selecting View | Y-axis | 
Log Scale to change from a linear scale or View | Y-axis | Linear Scale when the 
log scale is displayed. Bar Chart files may only be displayed with the axis they were 
stored with. Analogue and Leak Check modes only have a linear y-axis mode. 
 
When the logarithmic y-axis is enabled the highest and lowest gain ranges displayed 
may be adjusted by selecting View | Y-axis from the menu bar. Then click on either 
Low Gain Range or High Gain Range then click on Increase or Decrease. If you 
are already displaying the highest or lowest range the Increase or Decrease will be 
greyed out. 
 
When the logarithmic y-axis is enabled the gain ranges may be adjusted by using the 
four buttons on the settings bar which are described in section 1.6.3.4. Recall 
Settings Bar. When the upper or lower limit for a particular range has been reached 
the relevant button will be greyed out. 
 
 
2.4.2.  X-axis 

The x-axis command allows the user to display a portion of the mass range for Bar 
Chart files. Select View | X-axis . . . from the menu bar to display the Mass Range 
dialog box. Type in the value for the first mass and last mass in the appropriate box, 
then click on the Ok button. You can only choose values within the range of masses 
stored in the data file. 
 
 
2.4.2.1.  As relative time 
 
The time displayed on the x-axis in Multi-Trend, Leak Check and Fast Scan files 
may be shown as real time or elapsed time from the start of the scan. To change to 
elapsed time select View | X-axis as Relative Time from the menu bar. To change to 
real time select View | X-axis as True Time from the menu bar. 
 
 
2.4.3.  Cursor info 
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The cursor enables precise values to be displayed for measurements within the scan 
data window. The cursor is available when viewing files stored in all the modes but it 
operates in slightly different ways. To enable the cursor click on the Cursor button on 
the settings bar or select View | Cursor Info from the menu bar. A   tick is shown 
next to Cursor in the View menu when it is enabled. 
 
With Bar Chart and Peak Jump files click anywhere in the scan data window and the 
mouse pointer will move to the top of a peak. The peak value will be displayed in the 
cursor info bar immediately below the settings bar. You may then drag the pointer to 
other peaks and the value in the cursor info bar will change to show the value of the 
new peak.  
 
The cursor operates in exactly the same way for Analogue files except there are 16 
values for each peak. 
 
With Multi-Trend, Fast Scan and Leak Check files the cursor reading is displayed in 
a column added to the key panel when the cursor is enabled. As you move the mouse 
pointer along the x-axis the readings at that point are displayed. 
 
 
2.4.4.  Peak surround 

Peak surround is only available when viewing Peak Jump files. When peak surround 
is enabled a border is drawn around the peak in each enabled channel and the partial 
pressure reading is displayed above the peak.  
To enable peak surround click on the Peak Surround button on the settings bar or 
select View | Peak Surround from the menu bar. A   tick is shown next to Peak 
Surround in the View menu when it is enabled. 
 
 
2.4.5.  Alarms 

To view the alarm settings in a Peak Jump file select View | Alarms from the menu 
bar or click on the Alarms button on the settings bar. If high and/or low alarms were 
set when the file was stored the alarm settings will be displayed. If you move the 
mouse pointer over an alarm symbol (the triangle to the right of the peak) it will 
change to a question mark, if you then click the alarm value will be displayed. 
 
 
2.4.6.  Grid 

The grid is a series of horizontal lines or dots displayed under the scan data to help in 
reading measurements. To enable the grid click on the Grid button on the settings bar 
or select View | Grid or press CTRL+G. A   tick is shown next to Grid in the View 
menu when it is enabled. 
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2.4.7.  Total pressure 

To show the total pressure reading click on the Total Pressure button on the settings 
bar or select View | Total Pressure from the menu bar or press CTRL+T. The total 
pressure reading will be displayed between the cursor info bar and the settings bar. If 
total pressure was disabled when the file was stored the display will read “Total 
Pressure Off”. 
 
 
2.4.8.  Button bar 

The button bar is the row of buttons in the main Recall window immediately below 
the menu bar. You may choose not to display the Button Bar in which case the scan 
window will expand to use the extra screen space. The default setting is for the 
button bar to be displayed. 
To hide the button bar select View | Button Bar from the menu bar. A   (tick) is 
shown to the left of Button Bar in the menu list when it is displayed. 
 
 
2.4.9.  Settings bar 

The settings bar is the row of buttons in the scan window just above the scan data. 
You may choose not to display the settings bar in which case the scan window will 
expand to used the extra screen space. The default setting is for the settings bar to be 
displayed. 
To hide the settings bar select View | Settings Bar from the menu bar. A   (tick) is 
shown to the left of Settings Bar in the menu list when it is displayed. 
 
 
2.4.10.  Copy to clipboard 

The current scan displayed on screen as the active window maybe copied to the 
clipboard by selecting View | Copy to Clipboard from the menu bar or by pressing 
CTRL+C. This command is mainly used as a means of copying scans into a Recall 
Library where a scan is first copied to the clipboard then pasted into the library. The 
contents of the clipboard may be viewed by selecting File | Scan Clipboard, refer to 
section 2.1.8.  Scan clipboard.  
 
Remember the clipboard provides a means of transferring data. As you change data 
that has been copied from the clipboard the contents of the clipboard does not 
change. If you have edited the scan or performed a paste merge you will want to 
copy the modified scan onto the clipboard so that you can paste it into a library 
folder, for example. 
 
2.4.11.  Vertical legend 
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The times displayed on the x-axis in Multi-Trend, Leak Check and Fast Scan files 
may be shown horizontally or vertically. To change from horizontal to vertical select 
View | Legend Vertical from the menu bar. To change from vertical to horizontal 
select View | Legend Horizontal from the menu bar. 
 
 
2.4.12.  Continuous trace 

The traces drawn on screen in the scan data window with Multi-Trend, Fast Scan and 
Leak Check files may be shown as continuous traces or as a series of dots. To change 
the trace display click on the Continuous Trace button on the settings bar or select 
View | Continuous Trace from the menu bar. When selected a   tick will be shown 
next to Continuous Trace in the View menu and the button will be depressed. 
 
 
2.4.13.  Redraw 

The redraw command is only available when viewing files stored in the Multi-Trend, 
Fast Scan and Leak Check modes. Click on the Redraw button or select View | 
Redraw or press F4 to redraw the traces in the scan window. Redraw is usually used 
after the span settings have been adjusted using the Start At: and Span: settings. 
 
 
2.4.14.  Analogue 

There are some special commands which are only available when the active file was 
stored in the Analogue mode. The Analogue scan may be viewed as a Bar Chart by 
selecting View | Bar Chart from the menu bar or clicking on the Bar Chart button on 
the settings bar. To change back to an Analogue view select View | Analogue from 
the menu bar or click on the Analogue button on the settings bar. When viewing the 
scan as a Bar Chart the y-axis may be changed to a logarithmic scale by selecting 
View | Log Bar Chart Scale from the menu bar. To change back to a linear scale 
select View | Linear Bar Chart Scale. By selecting View | Twin Display from the 
menu bar or clicking on the Twin Display button on the settings bar, the scan 
window will be split to show both an Analogue view and a Bar Chart view of the 
data file. The Log/Linear Bar Chart scale will still operate as described above.  
 
When viewing an Analogue scan as a Bar Chart the Bar Chart peak height is 
determined from the area under the middle half a.m.u. of the analogue peak. It is not 
simply based on the maximum height of the analogue peak. 
 
 
2.4.15.  Edit text 

The Edit Text . . .  menu item is only available when the active window is the Scan 
Clipboard window displayed by selecting File | Scan Clipboard from the menu bar. 
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The descriptive text is displayed in a box above the scan data, immediately below the 
title bar. The text may be changed by selecting View | Edit Text . . . from the menu 
bar to display the Clipboard Scan Name dialog box. Enter a new description or 
modify the existing one then click on the Ok button.  
 
If the scan is literature library scan the Literature Library Folder Data Entry dialog 
box will be displayed and the Name, Formula and Table of Values may all be 
edited as described in sections 2.2.7.3.  Edit and 2.2.7.4.  Add . 
 
 
2.4.16.  Edit peaks 

The Edit Peaks . . . menu item is only displayed when the active window is the Scan 
Clipboard window. The Edit Peaks . . . menu item is only available when: 
a literature folder scan copied from a Recall library is displayed 
or 
a bar chart scan is displayed in the scan window and Recall has been started with the 
ability to edit peaks. For information on how to start Recall for Windows with the 
ability to edit peaks in bar chart scans see section 2.8 Switches. 
At all other times the Edit Peaks . . . menu item will be greyed out. The result of 
selecting Edit Peaks . . . is different depending on the type of scan (literature folder 
or bar chart) being displayed.  
 
When the Scan Clipboard window is displaying a scan from a Literature Library 
Folder selecting View | Edit Peaks . . . from the menu bar will display the Literature 
Library Folder Data Entry dialog box. In the title section type the name for the entry 
in the Name: box and its formula in the Formula: box. You do not have to enter a 
formula. The next step is to enter a value in the range 1 to 1000 for up to 15 peaks 
which will make up the spectra. Usually, the major peak is given the value 1000 with 
up to 14 minor peaks being given values relative to this.  
 
Position the cursor in the Mass: box and enter the mass of the major peak then, 
position the cursor in the Value: box and enter a value in the range 1 to 1000 
(usually 1000 for the major peak) then click on the Insert button. Enter the mass for 
the second peak, then enter a value and click on the Insert button. Continue in this 
way until all the required peaks have been entered. If you make a mistake while 
entering a Mass or its Value click on the Undo button to clear it and start again.  
 
Once you have some entries in the Table of Values you can click on one to highlight 
it. If you now click on the Delete button it will be removed from the list. Once an 
entry is highlighted its mass and value will be shown in the Mass: and Value: boxes 
where they may be modified then, click on the Change button to add the modified 
values to the Table of Values. 
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You may type text in the Comment box which will be displayed in the Recall (Scan 
Info) window.  
 
When all the information is correct click on the Update button to add the modified 
entry to the folder. Click on the Cancel button when you have finished to close the 
dialog box. 
 
When Recall has been started with the /e switch, see section 2.8.  Switches, and the 
Scan Clipboard window is displaying a bar chart scan selecting View | Edit  
Peaks . . .  from the menu bar will display the Scan Editor dialog box. 
  
The Scan Editor dialog box is an “always on top” window so you can move it in 
order to see peaks of interest in the scan. To edit the scan, start by selecting one mass 
you wish to edit and type its mass in the Mass box. The mass value must be within 
the range of masses displayed in the scan window. Click on the Action dropdown list 
box and then click on one of the five actions: 
 
Set To 
Set To Zero 
Subtract 
Add 
Scale By 
 
to select it. Position the cursor in the Value box and enter the required value. If the 
action is Set To Zero you do not have to enter a value. If you select Set To, Subtract 
or Add the value should be in the form aE-b where a is in the range 0.01 to 9.99 and 
b is in the range 5 to 16. 
 
 
2.4.17.  Paste from clipboard 

If there is a scan on the clipboard it may be pasted into the scan window by selecting 
Scan | Paste From Clipboard from the menu bar or pressing CTRL+V. Any data 
currently being displayed in the scan window will be overwritten and the data will be 
lost. 
 
 
 
2.4.18.  Paste merge from clipboard 

Paste merge allows you to combine a scan on the clipboard with a scan in the 
clipboard window. Paste merge in the scan menu operates in the same way as paste 
merge in the library menu. You can only merge into a Bar Chart scan in the scan 
window but the scan on the clipboard may be either a Bar Chart or a Peak Jump 
scan.  
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To merge a scan first make sure the scan in the scan window is a Bar Chart scan and 
you have a suitable scan on the clipboard. Then, select Scan | Paste Merge From 
Clipboard from the menu bar to display the Paste Merge dialog box. All the settings 
in the Paste Merge dialog box are explained in section 2.2.7.6.  Paste merge . 
 
When you have the correct settings click on the Merge Overwrite button. Merge 
Into New Copy is not available when merging into the clipboard window. 
 
 
2.5.  Channel menu 
The channel menu is only available when the active open file was stored in one of the 
three channel based modes (Peak Jump, Multi Trend, Fast Scan or Leak Check) or is 
a Bar Chart file being shown as a Trend. 
 
The channel properties are shown in the Channel window which is displayed by 
selecting Channel from the menu bar and clicking on the required channel number. 
If the active window shows a Peak Jump file the channel window can be opened by 
clicking on the channel button below the scan data. If the active window shows a 
Multi Trend, Leak Check or Fast Scan click on the mass number in the key panel to 
display the channel window.  
 
 
2.5.1.  The channel window 

The channel window shows various properties relating to the channel such as the 
mass setting, autorange status, values for high and low alarms if they were set. 
Except for the specific case detailed below all of the properties are for information 
only. Channels which were enabled when the file was stored may be disabled by 
clicking on the Channel On check box to un-check it. 
 
The one occasion when you can change the Mass: value is when you have opened a 
Bar Chart file and converted it to a Trend by selecting File | Show As Trend. The 
mass value displayed in each channel may be changed by positioning the cursor in 
the Mass: box and typing in the new mass. Only values within the mass range of the 
stored file may be entered or Total, if the file was stored with Total On. To display 
Total enter 0 or Tot as the mass. 
 
The properties of the next channel may be displayed by clicking on the Next button, 
clicking on the Previous button will display the previous channel’s properties. Using 
the Next and Previous buttons saves time as the screen is not redrawn after each 
channel is selected.  
 
Once all the channels have been configured click on the Ok button to implement the 
changes. Clicking on the Cancel button will close the Channel window without 
making any changes to the current channel. 
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2.6.  Window commands 
Click on Window in the menu bar to display the Window menu list. This contains 
standard windows methods for displaying multiple windows on the screen and a list 
of all the open windows in the Recall application. If you click on a file in the list it 
will become the active window and will be displayed uppermost on screen. 
 
Each Recall file that you open will initially be displayed as a minimized window, the 
data will be clearly visible but the window will not fill the full screen. Remember, 
you can open a file any number of times and each opening will cause a new window 
to be displayed. In this way you can display, say, scan 1 and scan 2 from the same 
bar chart file. If you click on the maximize button in the top right corner of the 
window it will be maximised and will fill the whole screen. If you click on the 
minimise button in the top right corner of the window it will be iconized (displayed 
as an icon). Any number of windows may be open but only one will be active. The 
active window will have a different coloured title bar (unless you have configured 
the colours to be the same for active and inactive title bars) than the other windows. 
 
 
2.6.1.  Cascading 

Select Windows | Cascade from the menu bar to display all the open windows on 
top of each other moving right and downwards on the screen so that all the title bars 
are visible. The active window will be uppermost. 
 
 
2.6.2.  Arrange icon 

Selecting Windows | Arrange Icons will cause the icons, displayed as a result of 
iconizing open windows, to be arranged along the bottom of the screen. 
 
 
2.6.3.  Tiling 

To change the display so that all the windows are fully visible select Windows | Tile 
Horizontal from the menu bar. Each open window will be reduced in size so that all 
windows are displayed on screen. Recall will try to display the windows horizontally 
(if only two or three windows are open they will be shown one above the other with 
each window using the full width of the screen) but will adjust the display to give the 
“best fit”. 
 
Selecting Windows | Tile Vertical from the menu bar will cause each open window 
to be displayed in a vertical manner with each window being fully visible on screen. 
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2.6.4.  Info window 

To display the Recall (Scan Info) window select Windows | Info Window from the 
menu bar or press CTRL+I. Remember, there is only one info window and the 
information in it relates to the active window. 
 
 
2.6.5.  Clipboard window 

To make the Scan Clipboard window the active window select Window | Clipboard 
Window from the menu bar or press CTRL+W. If the Scan Clipboard window has 
not been opened, by selecting File | Scan Clipboard, Clipboard Window will be 
greyed out in the Window menu. 
 
 
2.7.  Help 
Help in Recall for Windows operates in a similar way to Help in other Windows 
applications. Recall Help is a separate program which is accessed from Recall and 
can be entered without opening Recall by double clicking on the Recall Help icon in 
the Spectra program group. When you are working in Recall you can press F1 at any 
time to enter the help files. The most relevant help page will be opened. For instance, 
if you have clicked on Goto in the menu bar to display the Goto menu list then 
pressed F1 the Menus: The Goto Menu help page will be displayed. In this way 
Recall Help is context sensitive. 
 
Most help pages will contain text which is green and underlined indicating another 
help topic which is available. If you move the mouse pointer over this text the arrow 
will change to a hand, if you then click another help page will be displayed. 
 
If you select Help from the menu bar a menu list containing four items will be 
displayed, these are described below. 
 
 
2.7.1.  Contents 

Select Help | Contents from the menu bar to display the main contents page of 
Recall Help. There are number of main topic headings which you can click on to get 
further help. In the row of buttons at the top of the help window clicking on Contents 
will return you to this page. 
 
 
2.7.2.  Searching 

Select Help | Search for help on . . . to display the Help Search window which 
allows the user to find help on specific topics. Type in a word or words pertinent to 
the subject on which you require help. For instance, if you want help on opening files 
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you could type file. The list will then show all the items beginning with file. 
Alternatively, you can move through the list by using the scroll bar to the right of the 
list. 
 
Click on the required item in the list then click on the Show Topics button and the 
relevant help topics will be displayed. You can double click on the item to display the 
relevant help topics. Click on the required help topic in the list then click on the Go 
To button to display the help page. 
 
In the row of buttons at the top of the help window click on the Search button to 
open the Search window. 
 
 
2.7.3.  Getting started 

Select Help | Getting Started to open the Getting Started help page which will 
introduce you to Recall Help. Read through the text and follow the instructions. 
 
If you click on the Back button (one of the row of buttons at the top of the Help 
window) the previous help page that you were viewing will be displayed. You can 
continue to click on the Back button to move back through the help pages you have 
viewed in this session. The Back button will be greyed out when you are on the first 
page. 
 
Each time you view a help page the name of that page is added to the history list 
which can be displayed by clicking on the History button. That last page viewed is at 
the top of the list the first page at the bottom. If the list is too long for the window a 
scroll bar will be displayed to the right. Double click on any item to display that help 
page. 
 
 
2.7.4.  About 

Select Help | About Recall . . . to display the About window which contains 
valuable information for our service engineers should you ever need assistance. If 
you telephone for technical support please have the information from the Help About 
window ready. Click on the Ok button to close the About window.  
 
 
2.7.5.  Printing help pages 

Any of the help pages maybe printed out so that you have a hardcopy. To do this first 
go to the required help page so that it is displayed on the screen. Now, select File | 
Print Topic from the top of the help window. That particular help page will be 
printed. You can adjust the setup of your printer by selecting File | Print Setup . . . 
which will display the Print Setup dialog box where you can make any necessary 
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changes.  
 
 
2.7.6.  Help notes 

The user can add their own notes to the help files which may be useful for adding 
further details. To add notes firstly, select the page to which the notes will relate, so 
that it is visible on screen. Select Edit | Annotate . . .  from the top of the help 
window, the Annotate dialog box will be displayed. Type in the text for the note and 
click on the Save button when complete. Clicking on the Cancel button will close the 
dialog box without the note being saved.  
 
You should now see a green paper clip symbol displayed in the upper left corner of 
the help page indicating that there is annotation for that help page. Click on the paper 
clip to open the Annotate dialog box, or you can select Edit | Annotate . . . . The 
notes can be edited simply by typing new text and using the DELETE and 
BACKSPACE keys. 
 
Text from the notes can be copied to the clipboard by selecting the text using the 
mouse then clicking on the Copy button. Text can be copied from the clipboard into 
the notes by positioning the cursor at the required point then clicking on the Paste 
button. 
 
 
 
 
2.8.  Switches 
There are a number of “software switches” which may be used to control the way in 
which Recall for Windows starts up. Normally the user does not have to concern 
himself with these as they are automatically inserted during the installation and 
configuration process.  
 
To add a software switch in the Spectra program group click on the Recall program 
item to make it active 
 
select File | Properties . . . 
 
The Command Line will read C:\SPECTRA\RECALL.EXE assuming the default 
directory is used.  
 
The software switch is added to the end of the command line. All the software 
switches begin with a / forward slash and there follows a single letter and possibly a 
single digit number, depending on the switch. More than one switch may be used in a 
command line and there is a space before each / . 
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For example if the /E switch was added the command line would appear as follows: 
 
C:\SPECTRA\RECALL.EXE /E 
 
Upper or lower case letters may be used. 
 
 
2.8.1.  Software switches 

/E The /E switch is used to allow the editing of peaks in bar chart format on the 
clipboard, refer to section 2.4.16.  Edit peaks. 

 
/Hn  The Head switch, where n is the head number in the range 1 to 8. This allows 

Recall to look at the RGA4WINn.INI for certain settings such as background 
colour and channel masses. Only use this switch if you use different settings 
on multiple heads with RGA for Windows. 
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